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1 Introduction  
Thyristors and diodes are widely used in power 

electronics for controlling and rectifying high-

voltage and high-current applications. How-

ever, during switching events, these semicon-

ductor devices are prone to voltage transients 

and oscillations due to the inductive compo-

nents in the circuit. These transients can lead to 

voltage spike across the device, increased elec-

tromagnetic interference (EMI), and in some 

cases, permanent damage.  

Although semiconductor devices have an inher-

ent junction capacitance, this capacitance is 

often insufficient to control the voltage spike 

that occurs when a reverse voltage begins to rise 

during the turn-off phase. To mitigate the tran-

sient effects and ensure reliable operation, an 

RC snubber circuit is commonly employed [1]. 

An RC snubber circuit consists of a resistor and 

capacitor in series, connected across the thyris-

tor, as shown in Figure 1. This simple yet ef-

fective circuit serves multiple purposes: it sup-

presses voltage spikes, dampens high-fre-

quency oscillations, and aids in commutation 

processes. By absorbing the energy from tran-

sients and dissipating it safely, the RC snubber 

enhances the overall performance and longevity 

of the semiconductor device. 

 

 

Abstract—Thyristors and diodes are widely used in power electronics for their high current and 

voltage capabilities, but switching them can cause damaging transients due to parasitic effects. 

RC snubbers protect these devices by suppressing oscillations. This application note outlines the 

design of an RC snubber circuit for thyristors and diodes, focusing on mitigating transient volt-

age spikes during switching. Key factors such as resistor and capacitor sizing, device ratings, 

and parasitic effects are discussed. Practical design guidelines and a simulation tool are provided 

to help engineers optimise the snubber circuit. 
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Figure 1. A thyristor with RC snubber and 
commutation inductance, 𝑳𝐂. 

This application note provides a detailed exam-

ination of the turn-off process and reverse re-

covery in thyristors, followed by an exploration 

of methodologies for modelling reverse recov-

ery. It then delves into the design approach for 

selecting the R and C components in the snub-

ber circuit and introduces the Dynex simulation 

PLECS model for optimising these component 

values. 

It is important to note that, while this applica-

tion note primarily focuses on thyristors, the 

fundamental principles of RC snubber design 

also apply to diodes. 

2 Turn-off Process of a 
Thyristor 

This section discusses thyristors reverse recov-

ery and presents the most well-known methods 

for modelling it.  

2.1 Thyristor reverse recovery 
The thyristor waveforms during reverse recov-

ery are shown in Figure 2. When a thyristor is 

forward biased, the current flow is determined 

by both majority and minority carriers. If the 

forward current is reduced to zero by applying 

a reverse voltage, the thyristor briefly continues 

to conduct due to stored minority carriers in the 

PN junction and bulk material. This process, 

called reverse recovery, occurs as the minority 

carriers gradually recombine. 

During the reverse recovery process, initially, 

after applying the reverse voltage, the voltage 

remains near zero because the minority carriers 

continue conducting. As these carriers dissi-

pate, the thyristor's ability to conduct decreases, 

allowing the reverse voltage to rise. Once the 

stored charge is cleared, the device becomes 

non-conducting. In circuits with inductance, the 

sudden stop in current can induce a voltage 

spike due to the rapid release of energy from the 

inductive components. 

In Figure 2, IRR (also referred to as Irrm in the 

literature) is the peak reverse recovery current. 

VR (also referred to as VRM in Dynex datasheets 

and application notes) is the applied reverse 

voltage and VR(peak) is the peak transient re-

verse voltage.  

The reverse recovery time (trr) is measured 

from the point where the current through the 

thyristor drops to zero. It continues until a 

straight line, drawn after the current reaches   

IRR and heads toward zero, passes through the 

points corresponding to 0.9IRR and 0.25IRR in-

tersects the zero current axis. 

The reverse recovery period consists of two 

components: 𝑡A and 𝑡B. 

• 𝑡A: The time interval from the current 

crossing zero to reaching the peak re-

verse recovery current, IRR. 𝑡A  results 

from charge storage in the depletion re-

gion of the junction. 

• 𝑡B: The time interval from IRR to when 

the reverse recovery current returns to 

zero. 𝑡B results from charge storage in 

the bulk semiconductor material. 

 

  

Figure 2. Thyristor Turn-off Waveforms 
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The type of reverse recovery can be described 

by a softness factor, 𝑠, defined as 𝑠 = (𝑡rr −
𝑡A)/𝑡A. A larger softness factor indicates a 

"softer" reverse recovery, meaning the reverse 

current decreases more gradually, which can re-

duce noise and stress on the circuit. Addition-

ally, 𝐼RR is related to 𝑡A by the expression IRR= 

tA.(d𝑖T/d𝑡), where d𝑖T/d𝑡 is the rate of change 

of thyristor current. 

𝐼RR and reverse recovery charge, 𝑄S (which is 

also referred to as 𝑄rr and  𝑄r in the literature), 

depends on factors such as the junction temper-

ature, the rate of fall of the forward current 

(d𝑖T/d𝑡), and the magnitude of the forward cur-

rent before commutation (turn-off), IT. It should 

be noted that the dependence of the 𝐼RR and 𝑄S 

on IT, becomes negligible if the rate of current 

change (d𝑖T/d𝑡) is slow enough to create a 

quasi-stationary decay of the forward current. 

This condition is met when the ratio IT/(d𝑖T/
d𝑡) is at least several times greater than the car-

rier lifetime, which is typically in the range of a 

few hundred microseconds. In such cases, the 

forward current decays gradually, reducing the 

impact of the initial current magnitude on the 

reverse recovery process. 

2.2 Thyristor reverse recovery 
modelling 

In general, there are four well-known ap-

proaches for modelling the reverse recovery 

process of a thyristor/diode. These models can 

be used to estimate the peak reverse voltage 

during reverse recovery process. As shown in 

Figure 2, the reverse voltage remains zero until 

the reverse recovery current reaches its peak 

value, 𝐼RR. Therefore, to simplify the analysis 

in the reverse voltage calculation, it is assumed 

that the initial time (t=0) begins when the re-

verse current reaches 𝐼RR and the initial snubber 

capacitor voltage (at t=0) is zero. 

 

 
 (a) (b) 

Figure 3. Reverse recovery models. (a) 
Snap-off model. (b) Exponential decay and 
hyperbolic secant models.  

 

(a) (b) 

Figure 4. Equivalent circuit of a thyristor 
with snubber protection at t=0. (a) Snap-off 
model. (b) Exponential decay model.  

2.2.1 Snap-off reverse recovery cur-
rent model 

For the ease of analysis, the diode reverse re-

covery current can be assumed to snap off in-

stantaneously at 𝐼RR as shown in Figure 3(a). 

Therefore, in this approach, when analysing the 

circuit with a thyristor/diode during reverse re-

covery, it is assumed that at t=0, the thyristor 

behaves as an open circuit, and the initial cur-

rent in the commutation (stray) inductance is 

equal to 𝐼RR. An exemplary circuit for calculat-

ing the peak reverse voltage across a thyristor 

with snubber protection is shown Figure 4(a). 

2.2.2 Exponential reverse recovery 
current model 

In practice, the thyristor current recovers as 

showed in Figure 2, where the post-recovery 

current waveform is assumed to decay expo-

nentially. Therefore, when analysing the circuit 

with a thyristor/diode during reverse recovery, 

it is assumed that at time t=0, the thyristor acts 

as a current source, with the current decaying 

exponentially according to function (1). An ex-

emplary circuit for calculating the peak reverse 

voltage across a thyristor with snubber protec-

tion is shown Figure 4(b). 

𝑖T0(𝑡) = −𝐼RR𝑒−
𝑡
𝜏 (1) 

where 𝜏 is the decay time constant and can be 

obtained as (2). 

𝜏 =
𝑄S

𝐼RR
−

𝐼RR

2 d𝑖T/d𝑡
 (2) 

2.2.3 Hyperbolic secant reverse re-
covery current model 

In exponential recovery current model, as 

shown in Figure 3(b), the reverse recovery cur-

rent transitions sharply from its peak value to an 

exponential decay. This sharp change can lead 

to inaccuracies in modelling the real behaviour 
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of the current waveform. To address this, the 

hyperbolic secant recovery current model was 

introduced. While similar to the exponential de-

cay approach, the key difference lies in how the 

recovery current is represented. Instead of a 

sharp transition, this model creates a smoothly 

rounded reverse recovery current peak, which 

closely resembles measured transient recovery 

currents, as seen in Figure 3(b).  

In the circuit analysis approach using this 

model, the current source representing the re-

verse recovery behaviour of the thyristors/di-

odes follows a hyperbolic secant function, 

providing a smoother and more accurate depic-

tion of the recovery process. This approach re-

quires more complicated mathematical calcula-

tions and current source functions which are 

thoroughly discussed in [2].  

For semiconductor devices with typical soft re-

covery, the exponential model is highly effec-

tive and well-suited for calculating turn-off 

overvoltage. While the hyperbolic secant model 

offers greater accuracy, the exponential decay 

model remains the preferred choice due to its 

simplicity and ease of use, avoiding the need for 

complicated mathematical calculations.  

2.2.4 Circuit-based reverse recovery 
model  

In many practical applications, accurately mod-

elling the reverse recovery behaviour of diodes 

and thyristors is crucial for understanding their 

performance under switching conditions. Tradi-

tional models, such as the exponential decay or 

hyperbolic secant recovery models, rely on 

mathematical approximations to represent this 

behaviour. However, they often fall short of 

capturing the detailed physical effects present 

in real-world circuits and require computer cod-

ing, making them less convenient to implement. 

To address this limitation, the circuit-based re-

verse recovery model is introduced in [3]. As 

shown in Figure 5, this model incorporates ac-

tual circuit components, such as resistors, in-

ductors, and controlled current sources, to sim-

ulate the reverse recovery process accurately. 

By including physical components, this model 

offers a representation of device behaviour dur-

ing switching transients. 

 
Figure 5. Thyristor reverse recovery circuit-
based model. 

This model is also preferred because it provides 

a better balance between accuracy and usabil-

ity. It not only reflects the physical phenomena 

occurring during reverse recovery but also sim-

plifies parameter extraction by directly linking 

device characteristics to measurable quantities. 

Moreover, the circuit-based reverse recovery 

model is seamlessly integrated with simulation 

tools like PLECS, where it is already incorpo-

rated into the built-in diode and thyristor mod-

els. This makes it easy for engineers to use this 

model in their simulations, without the need for 

complicated manual setup, ensuring reliable re-

sults with minimal effort. 

This model is fully discussed in [3]. The values 

of all the components can be calculated directly 

from the datasheet using the equations provided 

in [3]. When using PLECS, no manual mathe-

matical calculations are required, as PLECS 

performs these internally. The users simply 

need to input a few constants from the 

datasheet, along with the specific requirements 

of their design. 

In the next section, we will explain how to use 

PLECS to perform snubber circuit analysis and 

estimate the reverse voltage during the reverse 

recovery process.  

3 Design of RC Snubber 
Circuit   

This section outlines a methodology for design-

ing snubber circuits for thyristors and diodes. 

The approach utilises PLECS simulations with 

the circuit-based reverse recovery current 

model. First, the use of PLECS to estimate the 
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reverse recovery behaviour of thyristors and di-

odes is explained. The simulation model devel-

oped by Dynex using PLECS is then intro-

duced. This simulation model is instrumental in 

optimising the resistance and capacitance of the 

snubber circuit, ensuring the desired voltage 

limitation during transients while minimising 

losses and capacitance.  

3.1 Thyristor/diode reverse re-
covery analysis in PLECS 

In PLECS, thyristors and diodes with reverse 

recovery capability can be selected. The model 

includes an internal circuit similar to the one 

shown in Figure 5. There is no need for the user 

to manually calculate the parameters in Figure 

5. Instead, the user simply enters the necessary 

input parameters required for those calculations 

as shown in Figure 6. 

Generally, the following parameters are 

needed: 

𝐼f0 in A and d𝐼r/d𝑡 in A/s, which represent the 

continuous forward current before thyristor 

turn-off (same as 𝐼T) and the rated turn-off cur-

rent slope under test conditions (same as 

d𝑖T/d𝑡), respectively. Based on the d𝑖T/d𝑡 and 

using the datasheet, values of 𝑄rr in C (𝑄S value 

in datasheet) and 𝐼rrm in A (𝐼RR value in 

datasheet) can be obtained. For 𝑡rr in s, set to 

0s, as its value is calculated based on 𝑄rr and 

𝐼rrm. For 𝐿rr in H, set to 1nH. 𝑉f in V and 𝑅on 

in Ω corresponds to 𝑉T(T0) and 𝑟T from the 

datasheet, respectively. 𝑅off in Ω is set to infin-

ity or to the datasheet value.  

 

Figure 7. An exemplar circuit for estimating 
𝑽𝐑(𝐩𝐞𝐚𝐤) of a thyristor with snubber protec-

tion during reverse recovery. 

In PLECS, the thyristor/diode with reverse re-

covery capability can be utilised in various cir-

cuit topologies to analyse its performance and 

impact on the circuit. For instance, as shown in 

Figure 7, a simple circuit can be used to inves-

tigate the peak reverse voltage of a thyristor 

during turn-off process, 𝑉R(peak), when using a 

snubber circuit. This analysis is conducted un-

der a specific applied reverse voltage, 𝑉R, and 

d𝑖T/d𝑡, determined by the applied reverse volt-

age and commutation inductance (𝑉R 𝐿C⁄ =

d𝑖T/d𝑡). 

3.2 RC snubber circuit design 
using PLECS 

The design of an RC snubber has two main ob-

jectives. The first is to suppress the peak reverse 

voltage to a value safely within the device's 

maximum capability, including an appropriate 

safety margin. The second objective is to mini-

mise snubber power losses and capacitance, 

thereby reducing the size and cost of the addi-

tional snubber circuit. 

 

Figure 6. The required data for reverse recovery current modelling in PLECS. 
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(a) (b) 

Figure 8. Snubber components optimisation 
trends. (a) Typical variation of 𝑽𝐑(𝐩𝐞𝐚𝐤) with 

𝑹𝐒 at a fixed capacitance (b) Typical varia-

tion of 𝑽𝐑(𝐩𝐞𝐚𝐤) and power losses with capac-

itance at the optimal 𝑹𝐒.  

Literature has demonstrated that, for each ca-

pacitance value, there is an optimal resistance 

point, 𝑅Optimum; deviations from this re-

sistance result in an increase in the peak reverse 

voltage. Additionally, increasing the capaci-

tance generally reduces the peak reverse volt-

age but leads to higher snubber losses. Beyond 

a certain capacitance value, the reduction in 

peak reverse voltage becomes minimal com-

pared to the increase in snubber losses. Figure 

8(a) and (b) effectively show these trends [1]. 

As mentioned, PLECS can be used to estimate 

the peak reverse voltage during reverse recov-

ery. Additionally, PLECS offers several other 

benefits, such as estimating power losses in the 

snubber circuit. Therefore, the circuit shown in 

Figure 7 can be enhanced with additional 

blocks for these estimations. Furthermore, by 

utilising PLECS simulation scripting, an opti-

misation algorithm can be developed in con-

junction with the simulation circuit to find the 

optimal solution based on specific require-

ments. 

Dynex has developed a PLECS simulation 

model (*.plecs) that can be conveniently used 

for this optimisation. The model is available for 

download on the Dynex website, with separate 

versions for thyristors and another for diodes. 

This simulation model, which requires only 

data available on the Dynex datasheet along 

with the converter's reverse applied voltage and 

commutation inductance, can be easily utilised. 

Once the necessary data is provided, the model 

determines the optimal resistance value for each 

capacitance that minimises the peak reverse 

voltage. The simulation model also shows how 

the peak reverse voltage and snubber losses 

vary with changes in the capacitance (at its cor-

responding optimal resistance). With this infor-

mation, the users can make informed decisions 

to select the best option based on their specific 

requirements. 

4 Design Examples Using 
Dynex PLECS Snubber 
Design Model 

This section provides two design examples—

one for a single-phase system and another for a 

three-phase system—to demonstrate how to use 

the Dynex PLECS simulation model for design-

ing an RC snubber. These examples guide the 

user through the design process, demonstrating 

how to optimise the RC snubber parameters to 

achieve effective circuit protection and perfor-

mance enhancement. 

4.1 Single-phase example  
In this section, an RC snubber is designed for 

the DCR4000M52 in a single-phase rectifier 

ensuring a voltage margin of at least 1000V. 

The maximum applied reverse voltage is 2600 

V, the commutation inductance is 500 μH, the 

maximum possible current prior to thyristor 

turn-off is 1000 A and gird frequency is 50 Hz.  

In the first step, d𝑖T/d𝑡 is calculated from (3), 

resulting in a value of 5 A/µs. 

d𝑖T

d𝑡
=

𝑉R

𝐿C
 (3) 

According to the DCR4000M52 datasheet, 

maximum values of 𝑄s and 𝐼RR are 9250 μC and 

170 A, respectively, at d𝑖T/d𝑡 of 5 A/ µs. In ad-

dition, 𝑉T(T0) and 𝑟T are 0.95 V and 0.24 mΩ, 

respectively. Assume 𝐼T 10000 A, ensuring that 

IT/(d𝑖T/d𝑡) is at least several times greater than 

the carrier lifetime.  

Open the Dynex PLECS Snubber Design 

Model, then navigate to Simulation > Simula-

tion Scripts. Enter the data as presented in Fig-

ure 9. All the parameters apparat from 𝑓 which 

is the switching frequency are defined in Sec-

tion 3.1.  

Once the data is entered, click "Accept" and 

then "Run".  
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Figure 9. The required data for optimisation 
in Dynex PLECS Snubber Design Model. 

After a few minutes, the optimisation results are 

displayed in graphs or can be accessed through 

the console by navigating to Window > Show 

Console, as presented in Figure 10(a) and (b), 

respectively. As shown, to account for a 1000 

V margin, the optimal configuration includes a 

capacitor with a capacitance of 1.5 μF and a re-

sistor with a resistance of 51 ohms. The values 

are rounded up/down based on the available 

standard resistance and capacitance in the mar-

ket. Additionally, the resistor must have a 

power loss capability of more than 700 W. 

This approach can also be extended to other to-

pologies, such as pulse power converters, AC 

switches, and various power electronics con-

verters incorporating thyristors and diodes. 

However, it is vital to ensure precise modelling 

and representation of the snubber circuit, ap-

plied reverse voltage, and di/dt experienced by 

the thyristors and diodes, especially when deal-

ing with more complex converter topologies. 

The following example, based on a 6-pulse con-

verter, shows how to achieve this effectively.  

4.2 Three-phase example 
In the common 6-pulse bridge configuration 

shown in Figure 11(a), in contrast to single-

phase rectifiers and AC switches, the RC snub-

bers interact with each other during turn-off 

process. For instance, when thyristor A turns 

off, thyristors B and C are conducting, effec-

tively short-circuiting their RC snubbers, while 

thyristors D, E, and F are in the blocking state, 

allowing their RC snubbers to influence the 

turn-off behaviour of thyristor A. This results in 

an equivalent circuit, as showed in Figure 

11(b), for this phase of the turn-off. 

 

(a) 

 

(b) 

Figure 10. The output results of Dynex 
PLECS Snubber Design Model for the sin-
gle-phase rectifier. (a) Graphs. (b) Data. 

Using standard formulas for the parallel and se-

ries connection of resistors and capacitors, the 

RC snubber seen by thyristor A during turn-off 

has an equivalent resistance and capacitance 

given by equations (4) and (5), respectively.  

𝑅Eq =
3

5
𝑅S (4) 

𝐶Eq =
5

3
𝐶S (5) 

An RC snubber needs to be designed for the 

DCR3370M65 thyristor in a three-phase recti-

fier, ensuring a voltage margin of at least 

1000V. The thyristor is subject to a maximum 

applied reverse voltage of up to 3500V, a max-

imum current of up to 1500A before turn-off, 

and operates at a grid frequency of 50 Hz. 

In the first step, d𝑖T/d𝑡 needs to be calculated. 

However, commutation inductance is not pro-

vided. When commutation inductance is not 
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provided for a 6-pulse converter, a worst-case 

line impedance of 5% can be used as (6) [1]. 

𝐿C = 0.05
𝑉LL

√3𝐼L

1

2𝜋𝑓
 (6) 

where 𝑉LL is line-to-line voltage, which is 3500 

V, 𝐼𝐿 is fundamental component of rated current 

which is 1500 A here.  

From (6), 𝐿C is 214 μH. d𝑖T/d𝑡 is calculated 

from (7), resulting in a value of 8 A/µs. 

d𝑖T

d𝑡
=

𝑉R

2𝐿C
 (7) 

In (7), the double inductance is due to the re-

sultant inductance in the commutating circuit 

for a three-phase rectifier.  

According to the DCR3370M65 datasheet, 

maximum of 𝑄s and 𝐼RR are 14000 μC and 260 

A, respectively, at d𝑖T/d𝑡 of 8 A/ µs. In addi-

tion, 𝑉T(T0) and 𝑟T are 1.04 V and 0.33 mΩ, re-

spectively. Assume 𝐼T 12000 A, ensuring that 

IT/(d𝑖T/d𝑡) is at least several times greater than 

the carrier lifetime.  

 

 

(a) 

  

(b) 

Figure 11. 6-pulse thyristor converter. (a) 
Schematic. (b) equivalent circuit when thy-
ristor A turns off. 

 

(a) 

 

(b) 

Figure 12. The output results of Dynex 
PLECS Snubber Design Model for three-
phase rectifier. (a) Graphs. (b) Data. 

Following the same procedures as single-phase 

rectifier example, the optimisation results are 

displayed in Figure 12(a) and (b), respectively. 

As shown, to account for a 1000 V margin, the 

optimal configuration includes a capacitor with 

a capacitance of 2 μF and a resistor with a re-

sistance of 39 ohms. 

However, 39 ohms and 2 μF are values of 𝑅Eq 

and 𝐶Eq, respectively. Therefore, from (4) and 

(5), the required snubber resistance, 𝑅S, and ca-

pacitance, 𝐶S, for each thyristor’s snubber are 

68 ohms and 1.2 μF, respectively. The values 

are rounded up/down based on the available 

standard resistance and capacitance in the mar-

ket. Additionally, the resistor must have a 

power loss capability of more than 1700 W.  

4.3 Reverse recovery waveforms  
After, selecting the customised optimum RC 

values, the reverse recovery waveforms can be 

observed from the same simulation model.  
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(a) 

 

(b) 

Figure 13. The required data for waveforms 
observation. (a) Single-phase rectifier. (b) 
Three-phase rectifier. 

To see the waveforms for the provided exam-

ples, navigate to Simulation > Simulation pa-

rameters > Initialization and enter the parame-

ters as shown in Figure 13(a) and (b). As 

shown, the only new parameters that are needed 

to be entered are the optimised snubber capaci-

tor and resistor. For three-phase rectifiers, 

please use (4) and (5) to calculate the new 

equivalent resistance and capacitance based on 

the standard rounded values for the snubber 

components.  

Once the data is entered, click "Ok", and then 

"Simulation>Start". To observe the waveforms, 

click "Waveforms".  

In Figure 14(a) and (b), the waveforms includ-

ing thyristor voltage, thyristor current, snubber 

current and snubber losses are presented for sin-

gle-phase and three-phase examples. As shown, 

the snubber circuits provide the required volt-

age margin. In Figure 14(a) and (b), the power 

losses graph represents the steady-state power 

losses in the snubber resistor, and the initial 

transient is ignored as this graph does not accu-

rately represent the power losses over time; 

only the steady-state value is relevant for as-

sessing the true power dissipation. 

 

(a) 

 

(b) 

Figure 14. Reverse recovery waveforms. (a) 
Single-phase rectifier. (b) Three-phase recti-
fier. 

4.4 Extra design considerations  
Other considerations when designing a snubber 

circuit include the following:  

▪ To reduce costs, standard resistance and 

capacitance values are typically used. 

The capacitance is chosen as the suppli-

er's standard value closest to the calcu-

lated need. A higher capacitance provides 

a greater safety margin but increases re-

sistor losses, while a lower value can re-

sult in higher voltage peaks. 

▪ Estimation errors can arise from factors 

like datasheet inaccuracies, simulation 

errors, and component tolerances. It is 

advisable to include a reasonable margin 

for the thyristor/diode voltage blocking 

capability and the power losses in the 

components. It is typically advisable that 

the estimated peak reverse voltage does 

not exceed 80% of the device's maximum 

voltage blocking [4].  

▪ When selecting a snubber capacitor, key 

factors include rms and repetitive voltage 

ratings. Capacitor reliability is affected 
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by voltage utilisation, ambient tempera-

ture, and self-heating. Generally, capaci-

tors should not exceed 70% of their rated 

voltage to ensure a long life. Critical pa-

rameters like peak and rms current rat-

ings must also be considered to prevent 

overheating. Proper mechanical design is 

essential to minimise heating from 

nearby components, as ambient tempera-

ture significantly impacts reliability. 

▪ Reliability literature recommends using 

resistors at no more than 60% of their 

power rating for a reasonable lifespan. 

For ambient temperatures above 60°C, 

further power reduction is advised. How-

ever, in applications where the worst-

case scenario duration for snubbers is 

brief, power loss margins can be opti-

mised to exceed 60%.  

▪ Resistors with low inductance and a lay-

out that minimises stray inductance in the 

snubber circuit should be chosen. High 

inductance leads to increased oscilla-

tions, reducing the snubber circuit's effi-

ciency. 

▪ A small snubber resistance could result 

from the calculation. However, this can 

lead to an excessive initial discharge cur-

rent when the thyristor is triggered at high 

voltage. This happens because the snub-

ber capacitor's discharge current adds to 

the load current during the thyristor's 

turn-on process. If the d𝑖𝑇/d𝑡 becomes 

too large, it may cause thyristor failure. 

Therefore, it's important to thoroughly 

evaluate the d𝑖𝑇/d𝑡 rating of the thyris-

tors in these situations, especially when 

the snubber needs to discharge quickly 

and frequently. In practical terms, this 

implies that the snubber resistor should 

not be too small. 

▪ The RC snubber circuit reduces dv/dt 

during the off-state, preventing unin-

tended triggering of the thyristor when 

dv/dt is too high. Furthermore, when thy-

ristors are used in series, the snubber 

helps maintain uniform voltage changes 

across the devices, ensuring the thyristors 

turn on simultaneously. 

5 Final Remarks   
This application note outlined the design of an 

RC snubber circuit for thyristors and diodes in 

rectifier applications. It discussed key factors 

like resistor and capacitor sizing, device ratings, 

and parasitic effects. Theoretical design guide-

lines and simulation tools were introduced, in-

cluding the Dynex PLECS simulation model, 

which can be used to optimise the R and C com-

ponents and evaluate their performance. Two 

practical examples, including single-phase and 

three-phase rectifiers, are provided to demon-

strate the use of the Dynex PLECS simulation 

model and to highlight additional considera-

tions necessary for effective design. 

The circuit simulation model presented in this 

application note is an original creation by 

Dynex, developed using the PLECS simulation 

platform. Dynex is neither affiliated with nor 

endorsed by Plexim GmbH. Users without a 

valid PLECS license can install the software 

and run simulations in demo mode. While this 

mode allows for simulation execution, it does 

not permit data export or model saving, so it is 

advised to run the simulations with a valid li-

cense for full functionality. 
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IMPORTANT INFORMATION: 

This publication is provided for information only and not for resale. 
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product failure or malfunction. 
 
The products must not be touched when operating because there is a danger of electrocution or severe burning. Always use 
protective safety equipment such as appropriate shields for the product and wear safety glasses. Even when disconnected any 
electric charge remaining in the product must be discharged and allowed to cool before safe handling using protective gloves. 
 
Extended exposure to conditions outside the product ratings may affect reliability leading to premature product failure. Use outside 
the product ratings is likely to cause permanent damage to the product. In extreme conditions, as with all semiconductors, this 
may include potentially hazardous rupture, a large current to flow or high voltage arcing, resulting in fire or explosion. Appropriate 
application design and safety precautions should always be followed to protect persons and property. 
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change. 
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